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New users of eVSM should begin with eLeanor, the eVSM learning and certification site at 

https://evsm.com/learn. eLeanor is a points based fun learning environment which uses multi-

media and facilitates anytime, anywhere, individual, or team based training. The eVSM Group 

also offers live instructor-led training, see details at https://evsm.com/services.

This reference guide complements eLeanor with functional descriptions of all the buttons in the 

eVSM toolbar.

The manual is designed for both on-screen viewing, and print. For on-screen viewing, save the 

PDF file to your PC and then open it in Acrobat Reader (not in a web browser). In the Acrobat 

menus, click “View>Page Display", make sure “Show Cover Page in Two Page View” is checked 

and then select "Two Page View”.

For hardcopy, print the manual on double-sided paper and use the table of contents or the index 

to quickly find answers to your questions.

How to use this book

Use Ctrl+F to 

Search in Acrobat 

Reader
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1. Sketch

Overview

Lists the sketcher stencils available and allows one to be selected. The 

corresponding Quick Stencil will also be activated. Note that only one 

sketcher stencil can be used per map.

Open

NUM Opens the Name Unit manager, which manages the names, units, and 

equations used on this map. If used in conjunction with a Quick 

Stencil, it’s important NOT to modify variable and unit names or 

equations. Typically, a few unit names might be added.

View a window showing all data for the selected center.

This section is focused on the first electronic capture of a map and data input. This area is ONLY 

for those using Quick stencils. 

List Variables

Wall Map Import a photo of an existing value stream map, and scale for drawing 

the map in eVSM.

Creates an input data sheet in the same folder as the Visio file and 

opens it up on the PC. You can now add data into the cells and then 

use the ‘Import XL’ button to bring the data onto the map.

Imports the data from the worksheet that was created by the ‘Create 

XL’ button. 

Scale locations of shapes on the page to stretch or shrink the map. 

Reverse the last stretch scale you applied.Reverse Scale

Scale Locs

Import XL

Create XL

Restack Re-arrange stacking of data shapes for add-ons to their default 

position.

2
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How Do I Use the Sketch Module?

The Sketch Module allows you to quickly capture a wall map in eVSM. It can also be used to 

simply capture the flow of the value stream with no data. Built in commands allow you to add the 

data later when needed. The main steps in the Sketch Module are:

1. Use the Wall Map button to import your wall map picture(s) into eVSM, and scale the image.

2. Use the Open button to select the application area (manufacturing, services, etc.) for your 

map.

3. Use the Sketch stencil to capture the flow over the wall map image. 

4. Once the initial capture has been done, add data to the map and enter the data. 

Import Single Image Wall Map

The Wall Map function provides an efficient way to convert an image of the wall into an 

electronic VSM. If your wall map is simple enough to capture in a single clear photo, (must be 

able to read all text), then import the image into eVSM with the steps below. If the map is 

complex and requires multiple images, then see section 1b on the next page. 

1. Click the Wall Map button in the toolbar.

2. Click the Insert Wall Map button to browse for 

your wall map picture on your computer.

Try this:

Wall Map

3. Select the picture and click Open.

3
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4. To scale the picture, draw a rectangle 

over any one process box. Click the 

Done button when finished.

5. Next a form will appear allowing you to change the 

transparency of the picture, make it visible/invisible 

on the page, or delete the picture. After you click OK, 

if you need to get back to this form, click the Wall 

Map button in the toolbar again.

6. The image will become the background of the Visio 

drawing page, allowing you to drop shapes on top 

without it moving. To delete the image, click the 

Wall Map button in the toolbar. 

Wall Map

Wall Map

4
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For more complex maps requiring multiple images, here are some tips for good results:

a.) Take all photos from approximately similar distance from the wall. This will ensure 

similar scale.

b.) Capture sufficient overlap between pictures so nothing is missed.

c.) Ensure lighting is similar for all photos.

d.) Hold camera square to the wall to minimize skewing of the image.

2. Line up the pictures so that the wall map is aligned 

properly. 

1. Use the Insert>Picture option in Visio to import all of the pictures on your Visio page.

3. Hold down the SHIFT key and select each picture. 

Right-click on the selected images and choose 

“Copy”.  

4. Delete the images from the Visio page.   

5. Right-click on the page and select “Paste Special”. 

Choose the “Picture (Enhanced Metafile)” option and 

click OK.

6. All of the images should now be joined into 

one single image. Crop or resize the image to 

fit the desired drawing page size. 

8. Click the Wall Map button in the toolbar, and follow the steps on the previous page of 1a. 

7. Click File>Save As. Name the image and then in the “Save as Type” dropdown, select 

“Graphics Interchange Format (*.gif)”. Click Save.

5
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1. To start drawing on your map, click on the Open button in the toolbar to open up the 

Sketcher stencil. From the pop-up menu, select which kind of map you’re drawing, for 

example, Quick Manufacturing. 

Open 

Try this:

The shapes shown above are those used in the example map.

As with all eVSM drawings, start your map by dragging out the red shapes (Customer Sketch and 

Time Sketch) first.

2. Once you select what type of map you’re drawing, the corresponding Quick Stencil will be 

placed in the forefront of the other Quick Stencils. Also, the Sketcher stencil will open with 

all of the shapes associated with that type of map.

Process

Type

Process

xx

Shift

Hr

5

Wk

Day

xx

Wk

Shift

Customer
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If you’re using a picture of a hand-drawn map as a guide, start dragging out the different Sketch 

shapes on top of each process as shown below. Otherwise, just recreate your basic process using 

the different Sketch shapes.

An alternative method can be done once a red shape has been 

placed on the drawing page. You can use the right mouse button 

menu, (shown to the right), and select the various Sketcher 

shapes to drop them at the location clicked on the page.

Note: If you need additional map space, 

hold down CTRL and click and drag the edge of the page.

 

3. Capture the Flow with the Sketch Stencil

Process

Type

Process

Type

Customer

Type

Process Process

Type

14

Day

Hr

5

Wk

Day
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Now you can either add data to an individual shape, or to the whole map. If you right-click on 

any shape, you will see 4 options regarding the adding and removing of data:

· Add all data (shape): adds input and calculated data to the specific shape that you have 

selected 

· Add all data (page): adds input and calculated data to all shapes on that particular page

· Remove all data (shape): eliminates the input and calculated data from the specific shape that 

you have selected 

· Remove all data (page): eliminates the input and calculated data from all shapes on that 

particular page

For this example, right-click on any shape and select “Add all data (page).

4. Add data to the map
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Annotate the map and fill in the values according to your wall map. Now you can finish the map 

by adding arrows from the eVSM Arrows stencil and add-on variables from the Quick stencil.
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Creating Paper Templates for Wall Maps

Wall maps can be drawn with any combination paper, pencils, markers, post-it notes, etc. 

However, such hand-sketches often result in a messy view, causing confusion instead of 

clarification.

With eVSM, you can create simple paper templates which facilitate efficient comprehension and 

help ensure no critical data is missed.
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%
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The templates can be customized for size, colors, units, and for the data items that need to be 

collected.Such paper templates work very well on smartsheets (electrostatic plastic sheets), 

magnetic boards, or even with just tape on a wall.

Steps to Create Paper Templates

1. On a new page, open the application stencil you want, drop the desired center on the page, and 

attach any add-ons you need.

PA0010

Cycle Time Secx.xx

Qty Per Cycle Item1

Process

SecAuto

Stations Stn1

Activity Time
Hr
Wk

x.xx
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PA0010

Cycle Time Secx.xx
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%x.xx

2. Clean-up the  center

Delete 

operation tag
Delete path ID

Delete product 

tabs
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datashapes

Clear center 

description

Clear all value fields 

in the remaining 

datashapes

After clean-up, the centers may look like these:
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3. For the printouts, do not resize the shapes. Just lay out one of more shapes on the page and 

then make the page small enough to just accommodate the shapes. Visio then allows you to blow 

up this page to whatever size paper you wish to print on. Here are examples of possible layouts. 

Our recommendation is to print at approx 2.5x normal size. So the activity center in the example 

below would be 4.5 inches (110 mm) tall.
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%
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4. When your page is ready, open the Visio Page Setup dialog box and set as shown here.

Select 

paper size

Set page 

orientation

Select Fit to 1 sheet. 

This will expand the 

small drawing to cover 

the full page

See here how your 

drawing will fit on 

the printer paper

5. Print and cut/trim the pages as needed.

12
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The Name & Unit Manager (NUM) provides a simple way of managing the names and units on a 

map via this toolbar button.

The purpose of this management environment is to:

1. Provide a means to type in a name only once and then use it consistently through out the 

map.

2. Provide a means to associate a default unit with a name so that when a name is selected, the 

unit is automatically set.

3. Provide a means of creating a starter set of names and units for different application areas 

such as manufacturing, healthcare, etc. This will allow a company to create standard 

variable sets and deploy them easily.

Managing Names & Units

NUM

The NUM function does not allow editing of names and units directly in the data shapes. New 

names must first be added to the NUM form. Then they can be accessed via right mouse button 

menus on the following data shapes.

Long NVU Short NVU Value Added Non Value Added Units 

Converter

The NUM form is divided into three parts: Sets, Units, and Names. Names and units visible in 

this dialog box represent the Current Set. Only the Current Set names and units are available on 

the right mouse button menu of datasets.

Add New Units

Current 

Names

Add New 

Names

Unit Converter 

Visibility

Name Unitx.xx Name Unitx.xx Minx.xx Dayx.xx

60

Hr

Min

Saved Sets

Current Units
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List Variables

To see a list of all of the data on a selected center, using the “List Variables” button will bring up 

a form with all of the hidden and visible data.

1. Select the green part of any center on your map. 

List Variables

The “List Variables” form can be left open as you click on different centers on the map. The 

form will update.

Try this:

2. Click the List Variables button in the toolbar to bring up this form.

#0A0080

Milling Station

Qty Per Cycle Item2

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

SecAuto

1

Cycle Time Sec10

Blue indicates 

calculated 

values

Black for input values. These 

can be edited here, just 

double-click.

[ ] for distribution 

data. Only in 

eVSM Mix

This switch allows you 

to shorten the list. 

What goes in the short 

list is controlled in the 

Views dialog.
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Since the List Variables form can get very long, you can customize what variables are shown in 

the list through the “Variable Visibility” form. Click the “Views” button in the toolbar.

The “Show in List Vars” 

column allows you to select 

which variables will appear 

in the List Variables form.

Views

15
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Restack

Re-arrange data shapes for add-ons to default 

position

PA0020
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Qty Per Cycle Item1
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Cycle Time Secx.xx
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Changeovers
CO
Day

1

Time Per 
Changeover

Min
CO

x.xx

Electricity kWx.xx

Gas kWx.xx

Compressed 
Air

kWx.xx

Energy 
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Item

Auto
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x.xx

Electricity kWx.xx

Gas kWx.xx

Compressed 
Air

kWx.xx

Energy 
Intensity

Wh
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Associates 
Direct

Staff1

Associates 
Indirect

Staff

Changeovers
CO
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PA0020
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Process A
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Cycle Time Secx.xx

Qty Per Cycle Item1

Process C
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Associates 
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Time Per 
Changeover

Min
CO
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Compressed 
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Energy 
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Associates 
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Changeovers
CO
Day

1

Time Per 
Changeover

Min
CO

x.xx

Electricity kWx.xx

Gas kWx.xx

Compressed 
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kWx.xx

Energy 
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Item
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Associates 
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Changeovers
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Day

1

Time Per 
Changeover

Min
CO

x.xx

Electricity kWx.xx

Gas kWx.xx

Compressed 
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kWx.xx

Energy 
Intensity

Wh
Item
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Often as you attached add-ons incrementally to centers, the data shape stack begins to look like 

this.

With variables in different positions at each center, it is difficult for the author and the audience 

to find the values they need to see, The Restack button, re-arranges the stack into a default order 

as shown below.
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Create XL/Import XL

Overview

It is sometimes easier to capture the value stream flow before any data is collected. This can help 

clarify what data is necessary. The data can be typed directly into data shapes on the map. 

Alternatively, the data can be collected in an Excel datasheet. Input is easier in Excel, and it also 

allows you to collect data directly in the Gemba on a mobile device (anything that Excel can run 

on). It also allows you to more easily have other people collect the data. The Create XL and 

Import XL functions allow you to create a datasheet for your map and then import the data onto 

the map.

Import XL

Create XL
Supplier

1A0010

Activity Lead 
Time

Day0

eVSM 
Data

QuickMfg
11.06.002

8.0

1A0020

Qty Per Cycle Item1

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

Process A

SecAuto

1

Cycle Time Min5

1A0040

Qty Per Cycle Item1

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

Process B

SecAuto

1

Cycle Time Secxx

Inventory

1A0030

Inventory Item700

DayAuto

A0050 1

Share % %100

Effective 
Demand

Item
Week

Auto

Customer

Customer 
Demand

Item
Week

500

52

Year

Week

70

Week

Hr

5

Week

day

U
n

it
s

Z0010

Total Value 
Added

MinAuto

Value Added 
Percent

%Auto

Takt Time
Sec
Item

Auto

Total Cycle 
Time

SecAuto

Time Summary

Lead Time DayAuto

#0

Visio Excel

Create XL

Creates an input data sheet in the same folder as the Visio file and opens it up on the PC. The 

new datasheet will be given the Visio page name along with “_INPUT”. If a previous datasheet 

already exists, it will be renamed to “_INPUT_bk” so any prior data entered is not lost.

You can add data into the cells, and then use the ‘Import XL’ button to bring the data onto the 

map. 

Import XL

Imports the data from the worksheet that was created by the ‘Create XL’ button. The format of 

the Excel datasheet must not be altered. Also, the location, filename, and the worksheet name 

must not be changed.

Import XL

Create XL
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Draw map with Import XL

The Import XL button also allows you to draw centers, (Activity center, Inventory, Transport, 

Supplier, etc.), automatically on the map. See instructions below.

New centers are added 

below the blue row

Select center type from 

pulldown list in this 

column

Enter 

center 

name

The data values are 

entered in the white 

cells

The data values must 

be in the units shown 

here

The new centers appear 

below the drawing page. 

These can now be moved to 

the required location

18



Copyright © 2021 The eVSM Group, All Rights Reserved 

Scale Locs

Reverse Scale

Scale Locs

While working on a map, you may need to keep many input and calculated values visible on the 

map. Your map could start looking like the one on the left below. The Scale Locs function 

explodes the view to look like the one on the right. The Reverse Scale function reverses the last 

scale expand.

Scale Locs
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2. Mix

Overview

Draw Sets

Show Set Colors

Isolate Set

Allows definitions of sets and the products within them. 

Draw needed Product Set Centers for any sets in the product data.

Shows set colors on the map.

Highlight activities for a selected Set Center. 

Mix Manager

Mix Manager

The Mix Manager dialog box is where the products and sets are declared for the Value Stream. 

The Mix Manager allows you to add new products/sets and edit/delete exiting items. It also 

includes functions to create products and sets via Excel. 

eVSM Mix is a separate product, and needs to be licensed/activated separately. The Mix icons in 

the toolbar and the Mix Stencils are only available if a valid license is active for eVSM Mix. 

Mix Manager

Display Gates Show set gates on map, where set is not allowed, shows a circle
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Importing the Product Matrix

Once the matrix has been used to identify the common routes, the data can be 

imported into eVSM by clicking the “Mix Manager” button in the toolbar, and then 

the “Import” button on the dialog box.

The import brings the products and routing sets into the dialog and also draws the activities at the 

bottom of the page. They can be moved into their map positions from there. You can add new 

products, or edit their routings directly in the dialog.
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Draw Sets

The Draw Sets button draws any sets that are defined in the Mix manager dialog which do not 

exist on the drawing page. The Product Set centers, (along with the product key), are drawn on 

the right side of the drawing page and can be moved to any desired location.

Route A

A0050 1

Set ID TxtA

Product 
Demand

Item
Day

0

Set Demand
Item
Day

Auto

Route B

A0060 2

Set ID TxtB

Product 
Demand

Item
Day

0

Set Demand
Item
Day

Auto

A - Route A
1 - P1 (Qty = 0.0 Item/Day)
2 - P2 (Qty = 0.0 Item/Day)
3 - P3 (Qty = 0.0 Item/Day)

B - Route B
21 - P21 (Qty = 0.0 Item/Day)
22 - P22 (Qty = 0.0 Item/Day)

Product Set 

centers Products key. Will 

update when value 

stream is Solved

Show Sets

The Show Set Colors button will create small colored squares for each set on applicable paths 

and activities, shown below. You can hide these squares using Visio layers(button on home tab), 

all you need to do is hide the layers “MixHighlight” and “HighlightShape” layers.

Note how Set A does 

not require the 

Thread operation

eVSM Data
Quick MixMfg
11.08.0000.0

Prod 

Da ta
Kaizen 

Data

A0030

Qty Per Cycle Item1

Stamp

SecAuto

Cycle Time Secx.xx

A0040

Qty Per Cycle Item1

Deburr

SecAuto

Cycle Time Secx.xx

A0050

Qty Per Cycle Item1

Thread

SecAuto

Cycle Time Secx.xx

A0060

Qty Per Cycle Item1

Assemble

SecAuto

Cycle Time Secx.xx

Route A

A0070

Set ID TxtA

Product 
Demand

Item
Day

0

Set Demand
Item
Day

Auto

Route B

A0080

Set ID TxtB

Product 
Demand

Item
Day

0

Set Demand
Item
Day

Auto

A0090

Customer

Customer 
Demand

Item
Day

0

52

Year

Wk

40

Wk

Hr

5

Wk

day

U
n

it
s

Draw Sets

Show Set Colors

Route sets in eVSM are used to group all products which go through exactly the same route. 

Routes are specified with sequence arrows. Where multiple sets share a sequence arrow, you can 

specify which sets can pass through with the “Sets Allowed” variable built into the sequence 

arrows. This variable can be made visible via the Views dialog box, or can be accessed through 

the List Variables button. There is also a an “Edit Set Gates” command available in the right-

mouse menus of the sequence arrows.

Sets
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Isolate Sets

Select a Set Center and click the ‘Isolate Set’ button. This will fade away any paths or centers 

that are not on that set’s production path. Set B was isolated in the example below. 

Isolate Set

Add/Remove Sets

These commands allow you to select a set center, and sequence arrows, and then click the Add/

Remove set buttons to open/close set gates.

Add Set Remove Set

Display GatesDisplay Gates

The Sets Allowed variable can be edited directly on each sequence arrow, however, for complex 

maps this can be very tedious. The Display Set Gates command makes this much easier. 

The command shows all set gates on all sequence arrows. Open gates are shown as squares and 

closed ones as circles. A right-mouse command, Set Gate Open, can be toggled to open/close set 

gates.
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3. Sequence

Set tag defaults that are used for auto-numbering shapes as they 

are dropped on the page.

First, select the activity shapes using the shift key in the 

CORRECT sequence, and then click this button to create sequence 

arrows. This can be done a few shapes at a time. Note that the 

'Check' section in the toolbar does have a hide/show for sequence 

arrows. No sequence arrow loops are allowed.

Many of the calculations on the value stream map rely on the process sequence. This is defined 

on the map by using tag sequence arrows. 

Tags

Sequence

Identifies each unique path through the value stream (via sequence 

arrows) and adds path ID’s to steps.

Assigns tags in the order provided by sequence arrows.

Auto Path

Auto Tag

Auto Pipe Select the activity from which to originate the pipe arrows, then 

hold down the shift key and select one or more activities to pipe to.

Overview

Auto Pipe – Many to One Select the activity to be at the head of the pipe arrow(s), then hold 

down the shift key and select one or more activities to pipe from. 

Select the source activity and using the shift key, select all 

downstream activities to connect the source to with tag sequence 

arrows. This button is located in the dropdown of the Sequence 

button.

Using the shift key, select the source activities from which to 

originate tag sequence arrows to a single downstream activity (the 

final shape you select while still holding down the shift key). This 

button is located in the dropdown of the Sequence button.

Seq One to Many

Seq Many to One 
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SequenceSequence

To attach tag sequence arrows to tags, select a series of tags (or activities) in the correct 

sequence, and then click the Sequence button in the toolbar.

The Tag Seq Arrow is used with Managed Equations and allows you to perform upstream and 

downstream calculations. This example shows how Accumulative Time can be calculated along 

the value stream with the use of Tag Seq Arrows.

Try this:

1. Select the shapes in the correct order using the SHIFT key. 

2. Click the Sequence button in the toolbar to automatically create sequence arrows to the shapes. 

If these shapes do not already have tags, using the Sequence button after having selected them in 

order will automatically attach tags to each shape.  

Process A Process B Process C

Managed Equation

Accumulated Time =

ST(CT;Min;0;APPLY)

  + ST(Transport Time;Min;0;APPLY)

    + UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

Process A

CT Min15

Accumulative Time Min15

Transport 
Time

Min10

Process B

CT Min20

Accumulative Time Min45

A0340

A0340

A0330

A0320

A0350 A0360 A0370
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Try this:

1. To use this function, select the center from which to originate the pipe arrows, hold down the 

SHIFT key, and then select one or more centers to pipe to. Resource A was selected, and then 

while holding the SHIFT key, Activity B and C were selected. 

2. Click the “Auto Pipe” button to automatically create pipe arrows from one activity to many 

activities. 

3. Fill in the pipe arrow data of Resource Process Time. This shows that Resource A is used for 2 

minutes per item for Activity B, and 5 minutes per item for Activity C. 

Auto Pipe – Many to One

Alternately, you can use the Auto Pipe – Many to One button, which is in the dropdown menu of 

the Auto Pipe button, to create pipe arrows from multiple Resources into an Activity. 

Auto Pipe Auto Pipe

Welders

Process X

Process Y

A0060

A0070

Resource PT
Sec
Itemxx

A0080

Resource PT
Sec
Itemxx

A

B

C

Process Z

Machinists

Packers

A0090

A0100

Resource PT
Sec
Itemxx

A0110

Resource PT
Sec
Itemxx

A

B

C

Pipe arrows are special arrows which allow data to flow between eVSM centers. Example usage: 

allocate resource hours to an activity center, or collect costs from select activities.

The Auto Pipe functions allow you to automatically create pipe arrows from one center to 

another, one to many, and many to one.

Auto Pipe – Many to One

Auto Pipe
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After your shapes have been sequenced, there is an option to automatically generate the path IDs 

for all the possible paths on the map based on the sequence arrows. After shapes have been 

sequenced using the “Sequence” button in the toolbar, click “Auto Path” in the toolbar. This will 

automatically give paths to the shapes in the order that they have been sequenced. If you make 

changes to the sequence, just click Auto Path again to update the path IDs.

Warning: Auto Path regenerates path numbers for all shapes connected by sequence arrows, and 

does this without consideration of the current path number on these shapes.

Auto Path Auto Path
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Tags

You can set preferences for activity tag numbering using the “Tags” form. 

To add or change an Operation Tag, first select the shapes you wish to attach a tag shape to. 

Click on the “Tags” button in the toolbar. After you  choose a tag prefix letter, next value, and 

increment value, click the “Add Tags” button.

A quick way to tag activities in order of the sequence arrows is to use the eVSM Auto Tag 

button.

AutoTag

The Auto Tag function works by re-tagging the whole map, so it disregards what you want as the 

“Next Value” in the Tag and Paths form. It orders the shapes by tag sequence arrows and then z-

order (for un-sequenced rows). It then goes through the sequence, and increments each tag by the 

user-assigned interval (in the Tag and Paths form), with numbers starting at 0010 for each letter 

prefix.

Tag numbers can also be named manually by double-clicking to edit the text, however, the name 

must be unique, and must be one letter followed by four numbers.

Charts are generally plotted in alphanumeric tag sequence, and the Auto Tag button does a great 

job to help charts plot in upstream to downstream sequence.

Auto Tag

Tags
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4. Validate

Overview

Must do this before using the Solve button. Performs numerous 

checks on the model and reports back any problems.

A visibility toggle switch for tag sequence arrows. Generally 

recommended that you work with these visible so you can fix 

sequence arrows as you modify the map.

Removes various highlighter shapes used for glue display, or 

problems displayed by the software.

This section contains checking functions to validate the model ahead of analysis. 

Check

Show Seq.

Clear

Show Pipes Just a visibility toggle switch for pipe arrows. Generally 

recommended that you work with these while visible so you can 

fix pipe arrows as you modify the map.

Select centers on map and then click the “Same Paths” button. This will 

highlight the common paths that pass through ALL of the selected centers.

Select centers on map and then click the “All Paths” button. This will 

highlight the paths that pass through ANY of the selected centers.

  View Paths View and highlight all the paths on the map. 

Same Paths 

All Paths
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Show Seq.

Clear

The Check function checks the map and highlights (with a red circle) some common problems. It 

also automatically fixes somethings such as unglued operation tags, unglued data shapes, and 

duplicate data shapes.

Check

Show Pipes

Check

Examples of problems the Check function will report:

· Missed mandatory data values

· Orphaned data shapes

· Unresolved units (missing units convertors)

When the Check function finds a problem that requires attention, it provides useful information 

to fix it. Be sure to read this information so you can quickly resolve the issue.

Hide/Show Sequence Arrows and Pipe Arrows

Clear all Highlighting

The Clear button clears the highlighting generated by the Check function, path highlighting, Set 

colors, etc.
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If you have various paths on the map, and want to see the common paths that go through multiple 

centers, then use the Same Paths button in the toolbar. 

You must first select which centers on the map you’d like to view the paths for. Hold down the 

SHIFT key if you want to select more than one center. In this example below, Process B and 

Process C are selected.

After the Same Paths button is clicked, Process B and Process C are highlighted, reminding you 

which centers were selected. Only the paths that go through both centers are highlighted, which 

are 1 and 2, shown in blue and red. 

To start a view with different centers, click the Clear button in the toolbar to clear all highlights. 

Alternatively, if you want to add centers to the original two you selected, just hold down the 

SHIFT key and select the new centers to add. Then click the Same Paths button again.

Clear

View Same Paths

Same Paths 

Same Paths 

Show Paths on Center

Show Paths on All

Hide Paths on Center
Hide Paths on All
--------------------------------------------------
All Paths
--------------------------------------------------
Select Paths

Set Path From View

If you have a view of the paths that you would like to set into a 

Path Filter for a summary or chart, use the right-mouse option on 

the Path Filter, and select “Set Path from View”. This was done for 

the example view above for paths 3 and 4.

all

Process A

Process B

Process C

Process D

Process E

A0010

A0020

A0030

A0040

A0050

#5

#3#3

#2

#4

#3

#4

#2

#3

Process A

Process B

Process C

Process D

Process E

A0010

A0020

A0030

A0040

A0050

#5

#3#3

#2

#4

#3

#4

#2

#3

#51

1

1

1

2

2

2

2

#5

  View Paths

32



Copyright © 2021 The eVSM Group, All Rights Reserved 

If you have various paths on the map, and want to see all of the paths that go through multiple 

centers, then use the All Paths button in the toolbar. In the example below, Process C and Process 

D were selected using the SHIFT key, and then the All Paths button was pressed. All of the paths 

are highlighted from Process C (3), and Process D (2).

View All Paths

All Paths

The right-mouse option on the Path Filter of “Set Path from View” will work for this function as 

well. 

Highlight Path Arrows

If you have multiple paths highlighted, like the red, green, or blue boxes, you can view their path 

by highlighting the sequence arrows in the matching color. If you right-click on any of the 

highlighted path boxes, there is an option to “Highlight Path Arrows”. This has been done for 

path 3.

Process A

Customer A

Process B

Process C

Process D

Customer B

A0060

A0070

A0080

A0090
A0100

A0110

#3

#2

#2
2

3

3

2

2

2
2

3

3

3

Process A

Customer A

Process B

Process C

Process D

Customer B

A0120

A0130

A0140

A0150
A0160

A0170

#3

#2

#2
2

3

3

2

2

2
2

3

3

3
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5. Calculate

Overview

Writes data out to excel, performs any calculations specified via 

managed equations, and, displays results back on the map. Also 

updates gadgets and charts on the map.

This section links the map to an underlying Excel spreadsheet to perform lean calculations with 

the results displayed back on the map. 

Solve

Variational Solve Calculates values using variational data.

Tag Operation VA NVA Data Data Data Data

v
a
lu

e
 a

d
d
e
d

n
o
n
 v

a
lu

e
 a

d
d
e
d

c
y
c
le

 t
im

e

d
is

ta
n
c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

Visio

The eVSM Solve button in the toolbar provides bi-directional transfer of information between the 

map and a spreadsheet. When the button is clicked for the first time in a map, eVSM 

automatically creates a new Excel file and puts it in the same folder that the Visio file is saved 

in. The function only operates on the current map page. All blue “Auto fields” will calculate to 

the appropriate values on the map.

The eVSM Calculator

Solve

Z0010 #0 Z0050 #0

Time Summary Time Summary

Total Value 
Added

MinAuto

Value Added 
Percent

%Auto

Takt Time
Sec

Item
Auto

Lead Time DayAuto

Total Value 
Added

Min1288

Value Added 
Percent

%24.34

Takt Time Min4.20

Lead Time Day12.60
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Variational Data

eVSM now supports simple means of specifying variation in data for selected input values, and 

creates variational output for designated calculated values. The example below is pulled from a 

Quick Manufacturing example map. Note that this functionality does not work with the Quick 

Transactional Pro stencil. 

1. Drag out a Normal Distribution icon from the eVSM Data and glue to the Cycle Time 

variable. Be sure that a glue connection appears.

2. The mean and standard deviation 

for the activity’s cycle time was 

entered.

Try this:

3. We want to see what effect this will have on the Lead 

Time. The Output Variation icon from the main stencil 

has been glued to the Lead Time of the Summary Center. 

4. The Variational Solve button is selected and the user 

selects ‘75’ solve iterations. Each solve uses a random 

number generator to “pick” a value from each variational 

input. It also creates a sample output for each designated  

variable. This is a simple type of Monte Carlo analysis.

Var Solve

5. Right-click on the Output Variation shape and select “Plot 

Output Distribution”.

6. The Lead Time has been plotted with the various confidence 

levels.

#0Z0010

Z0080 #0

Assemble

Time Summary

Cycle Time Min10

Total Value 
Added

Min15.00

Value Added 
Percent

%0.71

Takt Time
Sec

Item
2520.00

Lead Time Day2.52

Cycle Time Min20

Qty Per Cycle Item1.00

Capacity
Item
Day

84.00

sdm

Var Solve
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1. Connect a Variation Percentile shape from the eVSM Data stencil to the 

target variable, (lead time in the example below), and set it to 95.

2. Create a managed equation, (refer to the managed equations section), 

that equates lead time to the sum of the cycle time.

3. Press the Solve button in the toolbar and note that the lead time solves 

to 63.16. Without the percentile specification the answer would have 

been 50.

Variation Percentile Shape

The Variation Percentile shape, when attached to a variable that is calculated via equation, 

provides a way to access percentile values for any terms in the equation that have an associated 

distribution. In the example below, we want to calculate a lead time that will not be exceeded 

95% of the time.

Try this:

Solve

A0040

Process Process

Summary

Lead Time Min63.16 5Cycle Time Min20
820

Cycle Time Min30

A0020 A0030
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6. Visualize

Overview

Allows management of gadget families, providing geometric views of key 

numbers of the map with color coding, scale factors, and hide/show.

Updates all the geometric gadgets based on the current map values.

The view capability simplifies maps with better utilization of map space. it also allows the 

visualization of the numbers using gadgets and charts. 

Gadgets

Update

Views
Opens a window for modifying variable visibility settings for the map.

To prevent maps from looking crowded, there are a large number of variables in eVSM that are 

hidden. The views capability allows you to manage which variables you would like to be hidden/

visible on the map. 

ViewsHiding & Showing Variables

Try this:

1. Click the Views button in the toolbar.

2. This will open the form below which allows you to manage the visibility of variables on the 

map. The dark gray boxes indicate the hidden variables on the map, and white boxes represent  

the visible variables on the map.

3. Check the boxes of some variables that are currently grayed out.

4. Click OK and the changes will apply to all centers on the map.

Lets you hide Quick Centers on your map by having their corresponding 

rows in Excel hidden. This lets you keep as much data as you want in 

Excel, and use Excel's built-in filtering tools to control visibility in eVSM.

You can make a view permanent using the 'Copy Filter View' button, and 

make calculations on your map using that view.

Filter
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Reverts all Views settings 

to the Default, as they 

were when the map was 

first started.

Hides all the (blue) 

calculated data shapes

Switch off to hide all 

data shapes on map
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Using Gadgets to Visualize Data

Any data on the map can be linked to visual gadgets that change in size and color with change in 

the data. Some gadget types are shown below:

Each gadget has exactly one size parameter that can be tied to a data value on the map. Here’s 

the typical means used to apply and manipulate gadgets:

Try this:

1. Drag out the gadget from the eVSM Visuals stencil and position it near the data value with 

which it will be associated (in this case the “Cycle Time”). In this example, the Bar Height 

Gadget is being used.

Process

Cycle Time Min2

2. This system shape will be automatically dropped on the page the first time a gadget is used. 

If you copy a map to a new page, make sure you also copy this shape, because it is used to 

hold gadget data for the map.

3. Select the gadget, drag and glue the gadget’s yellow flying connector to the side of the 

NVU data shape (avoid gluing to the top or bottom of the data shape).

Process

Cycle Time Min2

Bar Height 
Gadget

Gadgets
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4. Right-click on the gadget and use the “Activate Gadget” option to create a new gadget 

collection. The collection name will be “Bar_Cycle Time”. The name is created from the 

gadget type and the data variable name.

A gadget can only belong to one collection. Each collection can only have a single type 

(e.g. “Bar”) of gadget.

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

5. You can change gadget scale factors and color code them by modifying the properties of 

the associated Gadget Collection. You can easily create additional gadgets tied to other 

instances of the same data on the map. Just click on the gadget and use the right mouse 

button to select, “Create Gadgets By Example”, to create the gadget for Process B below.

Process A

Cycle Time Min2

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

Process B

Cycle Time Min6

6. Note that the new gadget is automatically positioned, scaled, and put into the same “Bar 

Cycle Time” collection. If you do not wish to have new gadgets created for the whole map,  

first select the original gadget, then sub-select an area of the map before using the “Create 

Gadgets By Example” menu.

Process A

Cycle Time Min2

Process B

Cycle Time Min6
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7. To modify a gadgets scale factor, or to color code it, you need to change the properties of 

its associated collection.  Right mouse click on the gadget and select “Manage Gadget 

Collections,” or click the Gadgets button in the toolbar. Gadgets

To hide or show gadgets in a 

collection, first select the collection 

from a list, then click this button.

Note: the collection list has a column 

indicating visibility status.

You can modify the scale factor for a collection 

that controls gadget size in relation to data value. 

Use the Apply button to see the new  gadget sizes 

on the map before exiting the form.

You can color code the gadget fill and 

font colors based on the value of the 

data to which the gadget is glued. You 

can also simply “inherit” the color from 

the data shape, or assign a color to a 

gadget manually.
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§ Gadgets have a single size parameter that will scale to the data value in which a gadget is 

glued via the flying yellow connector.

§ Gadgets are typically glued to NVU, VA or NVA shapes. When gadgets in a collection are 

glued to data shapes with different units, Units Converters are needed on the map to 

compute the correct scale factors.

§ Gadgets have to belong to a collection. They can be put into a collection using the 

Activate Gadget command, or by transferring them into a collection via the Manage 

Gadgets form.

§ Gadget scale factors and color coding can be controlled via the Manage Gadgets form.

§ An easy way to create a gadget “set”, after creating a first gadget, is to use the Create 

Gadgets By Example in the right mouse button menu.

§ The Visible switch on the Manage Gadgets form is very useful in showing different 

metrics on the map in a presentation environment.

§ See the “Examples” section on the eVSM help site (www.evsm.com/help) for usage 

examples of the different gadget types.

§ A starter set of gadgets is provided with eVSM. Additional gadgets can be requested by 

contacting support@evsm.com.

Gadget Tips:
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Image/Text/Value/Unit Gadget

There are three gadgets that can be used to visualize hidden data in shapes on the map:

Image Text Gadget:

Text and Value Unit Gadget:

Text and Value Gadget:

For example, if you have kaizen bursts with various properties assigned, you can visually see 

them with the combination of image, text, value, and units. You can customize the font, color, 

and  size of the gadget to apply map wide. The instructions below will explain how to visualize 

the Impact number with the Text and Value Gadget.

1. The kaizen burst must have the properties you want to visualize already 

assigned. From the eVSM Visuals stencil, drag out the Text and Value 

Gadget and place it near the starburst.

2. Select the gadget, drag the yellow flying connector, and 

glue it to a glue connection along the edges of the starburst. 

Make sure a glue connection appears.

3. To change the “abc” to “Impact”, click the abc text box, and click the “F2” button on your 

keyboard to edit the text. This is where you can also customize the font size, color, and 

positioning as the standard.

Name Value Unit=

xx Unitabc =

xxabc =

xxabc =

xxImpact =

Problem

001

Problem

001
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4. Right-click the gadget and select “Activate Gadget”. 

5. Select “Impact” from the list. 

Once you click OK, the Impact number from the kaizen will be input into the gadget.

6. To apply this gadget to the rest of the kaizens on the map, right-click the gadget and select 

“Create Gadgets by Example”. You can manually move the gadgets, otherwise they will be 

created in the same location in relation to the starburst as the original one.

7. If you change any of the values shown by gadgets, you can click the “Update” button in the 

eVSM toolbar to update all gadget values. Update

4Impact =

Problem

001
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Conditional Color Gadget

The Conditional Color Gadget allows the ability to color code values 

based on value ranges. 

1. Drag out the Conditional Color Gadget from the eVSM Charts and Gadgets stencil.

2. Click on the gadget, and use the yellow flying glue 

connector to glue to any side of a variable. Make sure a 

glue connection appears, confirming that it is glued.

3. Right-click the gadget and click “Activate Gadget” if 

there is only one on the map, or select “Create Gadgets by 

Example” if you would like to add a gadget for that 

variable map wide. 

4. Click the Gadgets button in the toolbar. Gadgets

5. Select the Gadget collection.

6. Click the “Color Code” button.

#0A0020

Process

Qty Per Cycle Item1

OEE Percent %95.00

Sec15.00

1.00

Cycle Time Sec15

Scrap Percent %5

46



Copyright © 2021 The eVSM Group, All Rights Reserved 

7. Select “Based on Value Ranges(s).

8. Fill in the desired ranges 

with the fill color.

9. The Gadget will change to the color chosen. If values 

change, so will the gadget color after Solve is run. 

#0A0030

Process

Qty Per Cycle Item1

OEE Percent %95.00

Sec15.00

1.00

Cycle Time Sec15

Scrap Percent %5
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Filtering Views

The Filter button in the eVSM toolbar lets you hide Quick Centers on your map by having their 

corresponding rows in Excel hidden. This lets you keep as much data as you want in Excel, and 

use Excel's built-in filtering tools to control visibility in eVSM. Filter

The corresponding page name in Excel must be the page name you are using in Visio + “_ID”. So 

if the page name in Visio was “VSM”, then the Excel page name needs to be “VSM_ID”. 

The data must be started on row 2, with headers on row 1, and the first column named “ID” to 

identify the centers. Below is an example of the Excel sheet with the corresponding ID on the 

Activity Center. 

Configuring Excel

Configuring Visio

1. In order to specify the Quick Centers from Visio to Excel, an ID shape must be glued to it. 

From the “eVSM Data” stencil, drag out the “Long NVU” shape and glue it to the center. 

1A0010

#0A0020

Process

Process

Activity Lead 
Time

Day7

Activity Lead 
Time

Day0

ID TxtA

Name Unitx.xx
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2. Then click the NUM button in the toolbar to create an ID variable. NUM

3. Click the “New Unit” 

button.

4. Enter the unit name of 

“Txt” and then click OK.

5. Click the “New Name” 

button.
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6. Enter the Name “ID”.

7. Select the new unit “Txt” that was created. Then 

click OK.

8. Double-click on the Name field, and select the newly created “ID” NVU. Then click OK.

9. In the x.xx field, type the unique ID for that center. 

#0A0010

#0A0020

Process

Process

Activity Lead 
Time

Day0

Activity Lead 
Time

Day0

Name Unitx.xx

ID TxtA
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10. Once you have attached IDs to the desired Quick Centers, and hidden the rows in Excel for 

the view you want, then go back to the Visio file and click the “Filter” button. Filter

11. Once that view of the centers is configured on the page, a message will appear asking to close 

the filter view, or make a copy of that filter view to another page so you can make calculations 

on your map using that view.
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7. Improve

Overview

Allows the addition of improvement ideas on the map supported by the Impact matrix, Risk 

matrix, and Kaizen Report. 

Kaizen Properties

Kaizen Export

Kaizen Import

Renumber Kaizens

Select the kaizen/project property set for the map.

Creates an Excel spreadsheet of Kaizens with their property data.

Reads an Excel spreadsheet of Kaizens with property data back to 

eVSM.

Renumber the Kaizen shapes in the order they are selected. 

Numbering starts at 001, and any un-selected Kaizen shapes get 

numbered after the selected Kaizen shapes.

Kaizen Standardization

You can now standardize your kaizen custom properties by selecting the set of data for the 

Kaizens on the map. The Kaizen Properties button in the toolbar will bring up a form allowing 

you to select which properties to standardize on for the map. Kaizen Properties
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The Kaizen Export toolbar button scans the map for all Kaizen shapes (Starbursts), and exports 

custom properties associated with the shapes to Excel spreadsheets (Pagename_Kaizen). This 

Excel spreadsheet will show the connectivity of Kaizen starbursts with activities and other 

Kaizen starbursts. If you want to edit the custom properties data via Excel, you may do so, and 

import the data back into eVSM using the Kaizen Import button.

Kaizen 
Starburst

Generating Kaizen Report

Try this:

1. Open a blank Visio drawing page with the Quick Manufacturing stencil. 

2. Drag out an Activity Center.

Kaizen 
Starburst

Kaizen Export

Kaizen Import

Problems can be documented using Kaizen starbursts, which 

can now be connected to activities as well as to other 

Kaizens.

4. Click the Kaizen Properties button in the toolbar to bring up the form to see which properties 

are available as well as a description of each.

Check or uncheck the boxes to add/

remove properties to the standard 

custom properties list when editing 

each kaizen on the map. 

Kaizen Properties

Double-click the word “Visible” to 

toggle all of the properties on or off.

3. Drag out two Kaizen Starbursts from the eVSM Kaizen stencil. Edit the descriptions to 

“Reduce Changeover Times” and “More Frequent Deliveries”.

Reduce 
Changeover Times

001

More Frequent 
Deliveries

002

Problem

123
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5. Click the Kaizen Export button in the toolbar to create a Kaizen Report in Excel.

Kaizen Export

The Excel file 

looks like this

Values can be edited here and 

then imported into the map with 

the Kaizen Import button

Additional kaizen 

starbursts and clouds can 

be added here. These will 

be drawn at the bottom of 

the page on Import

The *_bk worksheet maintains the 

last copy of Excel report. This can be 

useful if you have made some 

changes in Excel and then run 

another Kaizen Export before 

importing the Excel changes

Facilitates some formatting 

control of the Kaizen report 

such as hide columns, text 

orientation, fill color.
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Kaizen Impact Matrix

Try this:

Kaizen Impact Matrix

Plot Kaizen Impact Matrix

2. Change the fill color of each starburst if you wish.

3. Drag out the Kaizen Impact Matrix icon from the eVSM Kaizen stencil and right-click to plot 

the matrix, which is shown on the next page.

The Kaizen impact matrix was introduced in a late version of v5 and uses the “Impact” and “Ease 

of Implementation” custom properties of kaizen starbursts to plot an impact matrix. The goal of 

the matrix is to help select projects for implementation to improve the value stream.

The mini-Kaizens in the matrix copy the custom properties of the originals (map Kaizens). They 

are numbered based on the ID’s of the Kaizens on the map (ID’s are circles glued to the top left 

of the kaizen shapes). A right-mouse click on any of the mini-Kaizens allows for selection and 

highlighting of the parent map kaizen. 

6

Highlight Kaizen

1. Change the Impact and Ease of Implementation properties of each starburst by right-clicking 

the starburst and selecting “Edit Kaizen”. A form will appear allowing you to edit the various 

properties. Similarly, you could also edit the values via Excel spreadsheet and use the Kaizen 

Import button to bring the values back into eVSM.

Impact (1-5):  What impact this project will have on 

the value stream.

1 = Low, 5 = High

Ease of Implementation (1-5):  How easy/difficult 

will it be to implement this measurable 

improvement to the Value Stream?

1 = Difficult, 5 = Easy

Kaizen 
Impact 
Matrix

Kaizen Import

Reduce 
Changeover 

Times

001

More Frequent 
Deliveries

002
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6. Drag out the Kaizen Key Creator from the eVSM Kaizen stencil to differentiate each starburst 

by description, which is shown under the matrix.

Kaizen Key Creator

5

4

3

2

1

1 2 3 4 5

Ease Of Implementation

Im
p
a
c
t 
O

n
 V

a
lu

e

Kaizen Impact Matrix

001

002

Kaizen Bursts

(001) Reduce Cycle Time

(002) Incorrect Assembly

4. If map Kaizens are modified, then the Impact matrix can be updated by selecting it with a right 

mouse click and the command “Update Chart”.

5. Using the Renumber Kaizen button in the toolbar, Kaizens can be renumbered in order starting 

at 001. Select the starbursts in the sequence you want using the Shift key, and then click the 

Renumber Kaizens button. Any un-selected kaizen shapes will get numbered after the selected 

kaizen shapes. Renumber Kaizens
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Kaizen Risk Matrix

Try This:

1. Drag out a Kaizen starburst shape from the eVSM Kaizen 

stencil. Type “Reduce Cycle Time” into the starburst. Enter the 

values for the likelihood and severity by clicking “Edit 

Kaizen” via right-mouse menu.

2. Drag out another Kaizen Starburst. Type “Incorrect 

Assembly” into the starburst. Enter the likelihood and severity 

values via the Edit Kaizen form.

3. Drag out the Kaizen Risk Matrix from the eVSM Kaizen 

stencil. Kaizen Risk Matrix

The Kaizen Risk Matrix plots the kaizen starbursts based on the risk likelihood and risk severity 

values set up in the “Kaizen Properties” form brought up from the right-mouse menu. It also 

multiplies the values together to create an RPN number between 1 to 25.

Risk Likelihood (1-5):  What is the 

likelihood of risk to the Value Stream if this 

project is not done/issue is not addressed?   

1 = Low, 5 = High

Risk Severity (1-5):  What is the 

likelihood/impact in the Value Stream if 

this identified risk did actually occur?   

1 = Low, 5 = High

Kaizen 
Risk 

Matrix

Reduce Cycle Time

001

Incorrect Assembly

002
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4. Right-click the chart shape to plot.
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Formatting the Kaizen Report in Excel 

Once you have clicked the Kaizen Export button in the toolbar and your Excel spreadsheet 

appears, there should be a page named “KaizenFormat”. The changes made on this page will 

effect the actual report which is page named “PageName_Kaizen”. 

In the “KaizenFormat” page in the spreadsheet:

· D1: Change the font color of this cell to set these properties for all Data headers 

· D2: Change the font color, boldness, or italics of this cell to set the default for the Property 

names

· D3: Change for the fill color or row height of this cell to set these properties for all units

· B5: Change the fill color of this cell to set this color for all kaizen numbers

· Each Property header can have a unique fill color, set by this page

· To hide an entire row or column, right-click the row number or column letter and choose 

“Hide”. To unhide that row or column, select the row before and after the hidden one by 

holding down the SHIFT key, or the column before and after the hidden one, and then right-

click and select “Unhide”.

The Kaizen Report in Excel can be formatted with custom properties of color, font, visibility, and 

row height. In order to be able to edit this formats, you need a specific Excel file. To get this file 

in the correct location for usage:

1. Create a new folder called "eVSM Standards" at the same level as the “eVSM” folder on the 

C: drive>Program Files (x86)

2. Copy the templates file called “eVSMExcelTemplate.xlt” from the C:Drive>Programs Files 

(x86)>eVSM>Setup>Resources folder to the newly created “eVSM Standards” folder

3. Customize the templates file as needed by following the instructions below

Try This:

Template page for 

editing properties 

for the Kaizen 

Report

Page name of 

Calculations 

page from 

“Solve”

A ReadMe page that 

lists any editing 

instructions for 

importing values   

Kaizen Report 

(PageName_Kaizen)

Excel Worksheets
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8. Extras

Overview

Map Copy

      Settings

      

Migrate

      Move Data

Provide utilities for upgrading older eVSM maps to v11.

Settings-

Change settings for this document that affect some features and 

performance of eVSM. 

Click the ‘Settings’ button to access the File Settings dialog box with 

the following options: 

Change settings for this document that affect some features and 

performance of eVSM.

Allows you to move your map data to a new page using a new stencil. 

Create a duplicate of all or a part of the current page to another page 

or another file. 

Map Extract Extract the selected page to a new file. 

Internal Solver: A new (faster) solver is available in beta mode and can be used if excel input/

output on solve is not required. 

Automatic Chart Update on Solve: Chart update takes significant time during solve. You can 

turn auto update off and choose to manually update charts. 

      Settings
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Automatic Units Parsing: When enabled, this allows input of values, like 1m 30s, wherever 

time measures are required. This saves time in capturing data. 

Excel Color Synch: When enabled, this synchronizes Excel cells and Visio shape colors on 

solve. This makes solve take longer. 

On Drop Variables: When enabled, data shapes (NVUs) dropped on the page are connected to 

the nearest center. 

Pre Solve Data Source Pages: When enabled, data sources on other pages than the main solve 

map will be solved also. This ensures the data sources on calculated values are always up to 

date.

Delete Assist: When enabled, eVSM will prevent you from accidentally deleting shapes, and 

will also delete an entire center when you delete the center parent shape. 

Trace Over Mode: When enabled, dropping centers from the stencil over shapes on a 

background page will make the dropped center ‘inherit’ the text and fill color of the shape 

behind. 

Separate Starbursts and Clouds: When enabled, eVSM will output Kaizen Starbursts and 

Clouds to separate Excel worksheets when you use the Kaizen Export. 

Hide Transparency Level: Impacts the brightness of shapes that are hidden by ‘fading’ them 

in the Layout, Customer Journey, and other eVSM applications. 

Cache Mixed Model Data: Faster editing of Mixed Model input data; requires you to run Auto 

Path after modifying arrows and/or centers on the page. 

NUM Mixed Model Solve Stages: Set number of Solve stages needed for Mixed Model solve.

 

Automatic Shape Positioning and Alignment: When shapes are dropped on the page, this 

enables easy insertion, automatic positioning to grid locations, and alignment to adjacent shapes. 
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Trace Over Mode

This function allows a partial conversion of an existing map or flowchart into a map in the 

current version of eVSM and for a stencil of your choice. This function is useful for converting 

non-eVSM Visio diagrams into eVSM maps, as well as for converting maps from one application 

(eg. Transactional, Manufacturing, etc.) to another. The only requirements are that it must be 

editable in Visio (cannot be a bitmap) and in your current eVSM file. 

Note: this is not intended to be a complete map conversion solution. It simply helps reduce 

typing and formatting. Also, helps ensure you don't miss anything critical.

Here are the steps:

1. If the original source map exists in a non-eVSM Visio file, then copy it to your current Visio 

file.

2. While source map page is active, add a new blank page to the file and make the source page 

it's background page. This will ensure that the new page is exactly the same size as your source 

map page. Now you should see the source map on your new page.

3. Convert the source map page into a Visio background page. Go to the flowchart page and click 

the “Page Setup..” command in the page tab menu.
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Tip: You can put a white semi-transparent box over the whole of the back-ground page. This will 

make all the background page objects faded out and make it easier to see what you are doing on 

your new drawing page.

4. Setup the Flowchart page  as the background page for your new page.

5. Switch the Trace over mode ON in the settings dialog box.

6. While on the foreground page, select the application for the map through the Open button in 

the toolbar and initialize the new page by dropping any red icon from the application stencil.

7. Now as you drop a center on each process step, the newly dropped shape will automatically 

pick up the text and fill properties of the underlying shape in the background page.
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Migrate Maps to eVSM v11

The migrate button will initiate migration of eVSM v8, v9, and v10 maps to eVSM v11 format. 

The conversion is not 100% so some manual work will be required after migration. For example, 

charts are not migrated, so they need to be re-plotted in the new file. The Views settings may 

also not be exactly the same.

Migration attempts to migrate all pages in the file and will create a new file for the current 

version. It will also add some markup in the old file to highlight items which have not been 

converted.

Recommended steps to migrate a file:

1. Backup the old file.

2. Open the old file to migrate making sure there are no other Visio files already open.

3. Hit the Migrate button. Migration will take some time for large files.

4. On completion, save both the old and the new files.

5. Scan through the old file to find items that are highlighted. These items have to be re-created 

manually in the new file.

6. Once you have completed any manual work in the new file, run the Check function on each 

page and fix any problems reported.

7. Run Solve and resolve any differences you see in calculation results.

Once a map is migrated to the current version, it cannot be opened in older releases of eVSM.

If you need to open a new version map in an old version of eVSM for viewing/printing purposes, 

here is a workaround:

1. In Visio, click "File > Options > Trust Center > Macro Settings > Disable all macros 

without notification". This will stop VBA from running the next time you start Visio.

2. Exit Visio.

3. Make a copy of the new version eVSM file, and open. 

Note: Remember to reverse Step 1 when you wish to re-activate VBA.

      

Migrate
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Move Data

Move Data allows you to convert a map from on e application type to another. E.g. 

Convert a Quick Mfg map to Quick Processing.

The conversion can not be 100%, but it will generally capture the flow and some of the 

data. 

The function allows you to select the target stencil and will create a new page where it 

will draw the flow with shapes from the target stencil, and then copy some of the data it 

considers equivalent. 

Steps:

1. Navigate to the original map page

2. Click ‘Move Data’ (located in Migrate drop down box)

      Move Data

3. Select the target stencil and click OK

4. The function will create a new page with the original page name, plus _ target stencil name.

5. Check and manually complete the new page. 
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To copy your whole map or a part of the map to another 

page, do not use the normal Visio Copy/Paste 

commands as this will miss some or the hidden data 

and will disrupt gluing between shapes in some places. 

Instead, use the Map Copy button. 

Simply select the part of the map you wish to duplicate, 

or select nothing to duplicate the whole map, and click 

the Map Copy button.

The dialog that pops up allows you to specify the 

destination which can be the current page, another 

existing page in the current file, a new page in the 

current file, or another file.

Map Copy Map Copy

Sometimes, selecting a part of the map is not trivial or tedious. In such cases, use the "Select 

Upstream" or "Select Downstream" commands in the right-mouse-button menus of the sequence 

arrows.

Partial Map Selection

Select All

Select Upstream

Select Downstream

________________________

Where From

Edit Sets Gates

Once the selection has the items you want, use the Map Copy button to duplicate.

This selection function is also useful if you have duplicated the whole map and then need to 

eliminate some segments.
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eVSM Visio files can have multiple pages, each with a different map or other diagrams. 

Sometimes such files can get too big to Email or do general work with. The Map Extract 

function allows you to extract a page or a part of a page into a new file. To only extract a part of 

a map simply select the shapes you want to copy and running map extract.

The page or the selected shapes in the old file is what gets extracted. The result will be a new 

one-page file which will be saved in the same folder as the original with the same name plus the 

page name. 

Map Extract Map Extract
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9. Help

Overview

Accesses the eVSM on-line help site.

Builds a page full of all the choices available in an eVSM Stack shape 

master. Select a blue icon (from any of the eVSM stencils on the right) 

or green icon (from any Quick stencil) before running this tool.

Provides an on-line access to help resources and training options. 

Help

Icon Search Search for shapes in eVSM stencils.

Stack Help

eLearning Opens the “My Gradebook” page on the eVSM website to check 

course status of eLearning material.  

Gives you information about your eVSM license and installation 

status.

Licensing

Map Clean Cleans your data by moving to a new Visio file. 
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Name Help

1A0020

Process

Qty Per Cycle Item1

Cycle Time Minx.xx

For variable name help, right-click any variable and select 

“Name Help” in the menu for a description of the variable.

MinAuto

Stack Help

Try This:

The Stack Help button creates a new page in the file with all of the available shapes for a 

selected stack. An icon can be identified as a stack shape if it is blue or green in an eVSM 

stencil.

1. Select the blue stack Transport Shape from the eVSM 

Material stencil.

2. Click the Stack Help button in the eVSM toolbar.

3. A new page will be created with the page name “Transport 

Shapes Stacks” in the file with all of the shapes in the 

Transport stack.

Stack Help
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Map Clean

As you work in a Visio file, over time, you may see some performance degradation as the Visio 

cache grows. The Map Clean function allows you to clean this up. It is essential creates a new 

empty file, and copies all your maps to it.

We recommend you run this if you suspect any corruption in the file, or, if you see performance 

degradation. It is a good idea to run the Map Clean function every couple of hours when working 

with large files. 

This function is also available through the Windows Start menu (useful if your eVSM toolbar is 

missing) at “Start > Programs > eVSM Software > eVSM Repair”. This will open the dialog box    

shown below. 

Just click the “Repair a Corrupt File” button and follow the prompts. 

Reset the eVSM 

environment to recover 

a missing eVSM toolbar

This is the Map Clean 

function

Map Clean
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Icon Search

The Icon Search button in the eVSM toolbar allows you to search for icons in any of the eVSM 

stencils. The search looks at the name and the brief help behind each icon and presents results in 

a separate search stencil.

1. Click the Icon Search button in the Learn module of the eVSM toolbar. 

2. Look for “OEE” in the Quick Mfg stencil.

3. The resulting shapes associated with OEE will be brought up in a new search stencil.

Try This:
Icon Search

Icon Search
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solve 34

stack help 69

T
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V
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